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Team Design Tutorial

The Team Design flow is a hierarchical design methodology that uses partitions to allow a large,
complex design to be broken up into smaller logical blocks.

e These blocks can be implemented independently and simultaneously.

e This allows each block to be individually designed, implemented, and verified in context with
the rest of the design.

e When all blocks are complete, the entire design is brought together in an assembly run in
which results can be imported and preserved.

A Team Design flow team consists of:
e One team leader

¢ One or more team members

Tutorial Objectives

This tutorial provides an overview of the Team Design flow. In this tutorial, you will complete a
design acting as a team leader and various team members. The objective of this tutorial is to
familiarize you with partitions and the Team Design flow using the PlanAhead™ software.

Project Setup

Initially, as team leader, you will:

e Define partitions on each team member block.
Each team member block is a black box.

e Define Pblocks.
e Review existing physical and timing constraints.

e Synthesize an initial version of the design using Xilinx® Synthesis Technology (XST)
incremental synthesis.

e Promote synthesis results for the Top partition.
e Run a Design Rules Check (DRC).
¢ Implement the initial design.

e Create PlanAhead projects for each team member.
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Team Member Work
When a PlanAhead project has been created for each team member, you will complete the work
of each team member as follows:
e Update the project to include actual design files for the team member block.
e Synthesize the updated team member design while importing the Top partition
Other team member blocks are black boxes.
e Implement the team member design.
Other team member blocks are black boxes.

e Promote successful synthesis and implementation results to a location accessible by the
team leader.

Design Assembly

The team leader then assembles the design by importing the results from each team member
project. You will:

e Assemble the design by importing the results from each team member project.

e Update the team leader project to include NGC files for each team member block.

e Set up implementation to import each team member block while implementing the Top
partition.

e Verify design assembles while maintaining placement and routing results from each team
member.

Software Requirements

You must have access to the ISE® Design Suite software to perform this tutorial.

Be sure that the PlanAhead tool is operational and the sample design data is installed before
beginning the tutorial.

The PlanAhead tool, Version 14.x, supports partitions in RTL projects targeting Spartan®-6,
Virtex®-6, and newer families.

For installation instructions and information, see the ISE Design Suite: Installation and Licensing
Guide (UG798) at http://www.xilinx.com/support/documentation/sw manuals/xilinx14 1/iil.pdf.
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Hardware Requirements

Xilinx recommends a minimum of 2 GB of RAM when using the PlanAhead tool on larger
devices. For this tutorial, a smaller xc7k70t design is used, and the number of designs open at
one time is limited. Although 1 GB is sufficient, it can impact performance.

Tutorial Design Description

This tutorial uses an incremental synthesis flow to create separate netlist for each partitioned
instance. These individual netlists are required for a team design flow.

The design used throughout this tutorial contains:

A RISC processor

e FFTs

e Gigabit transceivers

e Two USB port modules (to be partitioned)

e An xc7k70tfbg676 device

This tutorial uses a small design to:

e Allow the tutorial to be run with minimal hardware requirements.
e Enable timely completion.

e Minimize the data size.

Locating Tutorial Design Files

Download the PlanAhead_Tutorial.zip file from the Xilinx website:

http://www.xilinx.com/support/documentation/dt planahead planaheadl4-1 tutorials.htm

Extract the zip file contents into any write-accessible location.

The unzipped PlanAhead_Tutorial data directory is referred to in this tutorial as
<Extract Dir>.

The tutorial sample design data is modified while performing this tutorial. A new copy of the
original PlanAhead_Tutorial data is required each time you run the tutorial.
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Step 1: Opening a Project and Elaborating RTL

The PlanAhead design tool enables you to create several project types depending on where in
the design flow the tool is being used. RTL sources can be used to create a project for
development and analysis, synthesis, implementation, and bit file creation.

This tutorial uses an existing PlanAhead tool project, and focuses on the team design aspects in
the software. You will not create a new design using the New Project Wizard.

Opening the PlanAhead RTL Project

To open the PlanAhead RTL project:
1. Open the PlanAhead tool.

e On Windows, select the Xilinx PlanAhead 14 Desktop icon, or select Start > All
Programs > Xilinx Design Tools > Xilinx ISE Design Suite 14.1 > PlanAhead >
PlanAhead.

e On Linux, go to the <Extract_Dir> directory and type planAhead.
2. From the Getting Started page, click Open Project.

3. Browse to <Extract_Dir> and open the project file located at:
-/Projects/project_TL/project_TL.ppr

The Project Manager view opens. You can view the design source files in the Hierarchy window.
These files include:

e VHDL and Verilog files

e A User Constraint File (UCF) named top_full.ucf. The UCF contains timing constraints and I/O
pin locations.

Elaborating Elaborated Design

Use the Elaborated Design view to define partitions in an RTL project. When the Elaborated
Design view is opened:

e The RTL code is elaborated.

e The design hierarchy is displayed.

This is a pre-synthesized view of the design that is used to define partitions and create
constraints.
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To open the Elaborated Design view:

1. In the Flow Navigator, click Open Elaborated Design.

Flow Navigator i Project Manager - project TL
Q== Sources =

Cp 59 g ]
QT &0t BE

& Design Sources (5)

O
0
%

4 Project Manager

{5 Project Settings verilog (2)

& Add Sources | Werilog Header i 2)
wgh top (top.w (7)

L5 IP Catalog | Constraints (1)

(ll) Run Behavioral Simulation

4 RTL Analysis
¥ open Elaboratid DCesign

4 Synthesis Open Elaborated Design
@} Synthesi ﬂ_nalyze and constrain an elaborated netlist,
& Run Synthesis Hierarchy Libraries Compile Order
& Sources Y Templates

Figure 1: Opening the Elaborated Design View
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Step 2: Setting Partitions and Drawing Pblocks

The two usbEngine instances and the cpuEngine instance are all good candidates for
partitioning for the following reasons.

e They are logically isolated from one another and do not benefit from optimizations with
other blocks.

e They are timing critical blocks that can be developed independently and are beneficial to
preserve once implemented.

e The interface timing in and out of these blocks are not critical as they are registered.

You can use the PlanAhead design rule checks to help identify modules that are good
candidates for partitions.

You can floorplan partitioned instances just like any other instance. Creating Pblock
(AREA_GROUP) constraints can help achieve timing closure and improve runtime.

The steps below show you how to set partitions and create appropriate Pblock constraints for
the team member instances. Pblocks are required in a Team Design flow for each team member
partition.

Setting Partitions on Team Member Instances

To set partitions on team member instances:
1. From the Elaborated Design view, click the RTL Netlist tab.
2. Press Ctrl and select:

e usbEngine0

e usbEnginel

e cpuEngine

Team Design Tutorial www.xilinx.com 9
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3. Right-click.
4. Select Set Partition.

Elaborated Design - xc7k70tfbgs76-2 (active)

RTL Metlist - O a %
= H[E]
G top
@ = Nets (9200
@ = Primitives (12)
© clkgen (clock_generator)
& ;f;:;gg?fé?rg & Instance Properties..,  CtrHE
o~ (@ mgtEngine (md [ Copy Text CtrHc
H ushEngina {u % Export Statistics...
B usbEnginel {u
@~ @] whArbEngine
& Draw Phlock
Mew Phlock...
Set Par‘tition%
1] Select Primitives Ctrshift+s
£ Sources 2 H

Figure 2: Setting Partitions on usbEngine and cpuEngine Instances

Although three partitions are defined here, there are only two team members in addition to the
team leader. Both usbEngine instances are managed by a single team member because there is
only one set of Hardware Description Language (HDL) code associated with this module.

Drawing Pblocks for the Team Member Partitions

In this step, you:
e Define Pblocks.
e Review existing physical and timing constraints.

This step does not affect synthesis results. You could perform it post-synthesis in the
Synthesized Design view instead.
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To draw Pblocks for the team member partitions:

Step 2: Setting Partitions and Drawing Pblocks

1. Change the layout to be Floorplanning by selecting Layout > Floorplanning.

2. From the RTL Netlist window, select usbEnginel.
3. Right-click and select Draw Pblock.

Elaborated Design * - xc7k70tfhg876-2 (active)
Physical Constraints — O g %  RTL Netlist

oy G plg =
ey — (=5l H 5]

0
*

Ertl 1 Getop

L @ RooT S 5 Mets (9200

o= () Primitives (12)

: clkgen iclock_generator)
O cpuEngine (orl200_top)
[T] fftEngine (fftTop)
mgtEngine (rmgtTop)

— [ usbEngined (ushf top)

— O usbEnginel {ushf top)

o= [T] w @ Instance Properties...

3 Copy Text

% Export Statistics...
¥ Assign...

¥ Unassign

Instance Properties - 0O

0
ps

Ctri+E
CtriHc

& Draw Phigck

« + B[R] |

Figure 3: Selecting the Draw Pblock Tool

MNew Pblock...

4. With the Draw Pblock tool active, move the cursor to the Device window.

5. Click the top-left corner of the device where the CLBs start (reference Figure 5 for completed

view).
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Step 2: Setting Partitions and Drawing Pblocks

6. Drag down and to the right to create a rectangle covering most of the top-left quadrant of

the device.
RTL Netlist — O g ® | EFroject Summary < & Device ] RTL Schematic
= H(E| l
Gt top
@ [ Mets (9200 *
@= [ Prirnitives (12) :
o~ [@ clkgen (clock{ . Fm New Pblock

[ cpuEngine (o
@= [G] fitEngine (fftT]
o mgtEngine (rl
[ usbEngineo (| | Srids

O usbEnginel (| | & 5 icE (2400)
@= [G] whirbEngine N

Name: [pblock_ushEnginel]|

[ DsPas (20}

[] RAMBELSE (20)

¥ RAMB3E (40)

[¥] Assign selected instance

F—

44 Sources. [ RTL Netlist

Figure 4: Pblock Rectangle for usbEnginel

7. In the New Pblock dialog box:
e Verify that the SLICE and RAMB36 grids are selected.
e Deselect other resources that are not needed.
e Verify that the number of available RAMB36 is 40.

If the rectangle does not fully cover the region shown in the figure above (Pblock Rectangle
for usbEnginel), the design may fail to place.

8. Click OK.

9. If the number of available resources are different than shown, adjust the size of the Pblock
rectangle by selecting it and resizing.

e SLICE (2400)
e RAMB36 (40)

10. Repeat the steps above for usbEngineO0 in the bottom-left quadrant.
Only SLICE and RAMB36 (40 of them) are required for this block.

Team Design Tutorial www.xilinx.com 12
UG839 (v14.1) April 24, 2012


http://www.xilinx.com/

iA X"—l Nxf Step 2: Setting Partitions and Drawing Pblocks

11. Repeat the steps above for cpuEngine in the bottom-right quadrant.

For cpuEngine, the Pblock contains all four ranges, and may be defined as clock regions
X1YO to X1Y1 as well:

e CLOCKREGION_X1YO0:CLOCKREGION_X1Y1
Or as individual sites

e SLICE (2600)

e DSP48 (40)

e RAMBL1S8 (80)

¢ RAMB36 (40)

|1T!'IIIIIIIIIIIIIIIIIIII

Figure 5: Completed Floorplan for Pblocks usbEngine0, usbEnginel, and cpuEngine
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Step 3: Synthesizing and Implementing the Design

In the previous steps, you:

e Defined partitions on the elaborated HDL design.
e Created constraints.

In this step, you will:

¢ Run synthesis.

e Run DRC.

e Run implementation.

During synthesis, XST recognizes that the design has partitions, and runs the design through an
incremental flow.

In this flow XST generates individual NGC files for each partition. In this design the top partition
contains all logic in top.v, as well as all logic from hierarchical blocks that are not their own
partition (fftEngine, mgtEngine, and wbArbEngine). All of logic from the top partition will be
synthesized to "top.ngc”. Since the instances usbEngine0, usbEnginel, and cpuEngine are
black boxes and contain no logic in this initial project, no NGC files will be generated for these
partitions.

This tutorial uses an RTL project. For a bottom-up or third-party incremental synthesis flow:
e Run synthesis outside the PlanAhead tool.

e Use a netlist project instead of an RTL project in the PlanAhead tool.

Team Design Tutorial www.xilinx.com 14
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Running Synthesis

This design uses default synthesis options.
To run synthesis:

1. In the Flow Navigator, click Synthesize.

Flow Navigator « Elaborated Design * - xc7k70tfbg576-2 (active)
Q= RTL Metlist —O@x
= Hi[E]

- Project Manager

Gitop
. e= [ Mets (920)
“ RTL Analysis & = Primitives (12
< Elaborated Design @~ [4] clkgen (clock_generator)
@ Report DRC E cpuEngine (orl200_top)
: o= [d] fitEngine (fftTop)
El Report Noise @ mgtEngine (mgtTop)
E Report Utilization E usbEngined (ushf top)
Pel] sch ti E ushEnginel fushf top)
i senematie ©= [T wharbEngine (wh_conmax_topldw=32,aw=321_addr=4'bl
4 Synthesis
#5 Synthesis Settings

& Run Syrthesis

I} P | _J

rl
Run Synthesis {F11}
Run synthesis on your project source files.

4 Implementation

Figure 6: Launch XST Incremental Synthesis

2. Before running synthesis, PlanAhead saves all partition and floorplan changes. If prompted
to save your design, click Save.

3. After synthesis completes a Synthesis Completed dialog box will appear. You can either
choose to Open Synthesized Design, or Cancel the dialog and open the Synthesized
Design in the next step.

Running DRC on Partitions

You can run a Design Rule Check (DRC) on the Elaborated Design, although the checks at this
stage are limited. Xilinx recommends that you run a DRC on the post-synthesis design before
implementation.

To check DRC, load the Synthesized Design view, and run partition-specific DRCs.

1. If not already open, open the Synthesized Design view by clicking Open Synthesized
Design to in the Flow Navigator.

This loads the synthesis results and allows for additional DRC checking.

2. Click OK on the Undefined Modules dialog. It is expected to have black boxes in the design
at this point.

3. In the Flow Navigator under Synthesized Design, click Report DRC.

Team Design Tutorial www.xilinx.com 15
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Step 3: Synthesizing and Implementing the Design

4. From the Report DRC dialog box, deselect all rules except Partition and Team Design.

Besults Mame: |drc_1

Output File: I

B

M g A
b ¥ o pig

Fules to Check: 13 of 1233

@-0d All Rules (1233)
@~ Bank (12)

[ IoB (19)

[ Placer (14)

[ Metlist (1158}

[ Floorplan (5)

[ ClkBuf (1)

[@ DsP48 (4}

[ RAME (1]

Partition (10

O 0 g Oy 0 ey O g 3y O

Team Design (3)

Select All H Clear All ]

¥ Open in a new tab

Ok

Cancel I

Figure 7: Run Partition Design Rule Checks

The PlanAhead tool can report the following message types for the DRC rules:

5. Click OK.

DRC Messages
e Advisory

e Warning

e Error

e Fatal

In this case, the DRC returns several warning messages. Ignore them. The DRC messages are

caused by the black boxes in the design.

In an actual design, investigate all DRC messages, and correct any serious issues.

Running Implementation

Before transmitting the design to each team member, the team leader may now run
implementation to check that all timing and floorplan constraints are valid. Because the two

Team Design Tutorial
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usbEngine instances and the cpuEngine instance are black boxes, no real useful
implementation results are obtained.

To run implementation:

1. In the Flow Navigator, click Run Implementation.

2. Click the Report tab to see a list of all implementation reports.
3. As each process finishes, the related reports are available for review.
4. After NGDBuild finishes, double-click the NGDBuild Report to open the report.
5. Scroll to the bottom of the report file to review the partition information.
I Project Summary & Device 2 NGDBuild Report - impl_1 Og x
110 [~]
111 Partition Implementation Status
112 | R
113
~ 114 Preserved Partitions:
e |115
2 11s
(117 Implemented Partitions:
1118
118 Partition "/top":
120 Attribute STATE set to IMPLEMENT.
121
& 122 Partition "/top/cpuEngine" {(Black Box Module}:
U123 Attribute STATE set to IMPLEMENT.
4 [124
& 125 Partition "/topsusbEngined” (Black Box Modulel:
S |125 Attribute STATE set to IMPLEMENT,
o |127
Y l1zm Partition "/topfusbEnginel” (Black Box Module]:
126 Attribute STATE set to IMPLEMENT.
= 130
Allm |
¥ (132
133 MGDBUILD Design Results Summary:
134  Mumber of errors: a
135 Mumber of warnings: 18
135
137 Total memory usage is 538100 kilobytes
133
138Writing MGD file "top.ngd" ...
140Total REAL time to MGDBUILD completion: 55 sec
141 Total CPU time to NGDBUILD completion: 27 sec
142
143Writing MGDBUILD log file “top.bld"...
144 [~

Figure 8: Partition Implementation Status in Report Files

The three team member partitions are all listed as Black Box Module. Partition information is
provided in every report file (NGDBuild, Map, and PAR). This allows you to easily verify the status
of all partitions on a given run.
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Step 4: Promoting Synthesis and Creating Team
Member Projects

The design is now ready for the team members to start their work.

e Before generating PlanAhead projects for each team member, promote the initial synthesis
results.

e Because the implementation results of the previous step are not used by team members, the
implementation results need not be promoted.

Promoting Successful Synthesis Results

To promote the successful synthesis results after synthesis (or implementation) has completed:
1. Click Promote Partition in the Flow Navigator (located under Implementation).

2. In the Promote Partitions dialog box, select only the Top partition to be promoted in the
synth_1 run.

Flease select entire runs or specific partitions to be
promoted. This copies the partitions in implemented run to
the specified promote directory, After promoting runs, you can
import the partitions into runs.

Select Partitions to promote
G g

g A

Run |Directory |Description
¥ synth_1  [2romote/topssynth 1 ||:||rrL synth run
— b top
—[d cpuEngine

[ ushbEngined
[ usbEnginel

@impl 1 [/Promoteftopimpl 1 || -
—[d top
[ cpuEngine

[ usbEngined

L[ usbEnginel

Select Implemented || Clear All |

[ lautomatically manage Partition action and import location

| (a]¢ J | Cancel

Figure 9: Promote Partitions Dialog Box

Do not to promote other partitions at this stage. No useful data exists for the other
partitions. Promoting them will require additional steps by each team member to change the
promoted partition state values back to implement for their runs.

Team Design Tutorial www.xilinx.com 18
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3. Set the Promote directory for synth_1 to:
<Extract_Dir>/Promote/top/synth_1

The default Promote location could be used, but since this promoted data will be accessed
by multiple team members it may be desirable to Promote this to a location external to the
project directory.

4. Enter an optional description about the promoted data.
5. Verify that Automatically Manage Partition Action and Import Location is checked.

Checking Automatically Manage Partition Action and Import Location enables the
PlanAhead tool to update the partition state and import location for the next synthesis run,
whether by the team leader or by a team member. If this box is not checked, the team
leader must manage these attributes.

6. Click OK to promote the Top partition synthesis results.

7. View the changes caused by promoting partitions. See the figure below (Promoted Partitions
Window).

8. A Promoted Partitions tab now appears in the Elaborated Design view.
If you do not see this tab, select Window > Promoted Partitions.

The Specify Partitions dialog box now shows that the Action on the Top partition is Import. To
open the Specify Partitions dialog box, click the Specify Partitions button in the Flow
Navigator.

Promoted Partitions — 0O o =
SN
Promoted Directory |Run |F'r0... |Deacripti0n
@-I# ... Promoteftopfsynth (1) synth_ 1 3/28... |TL synth run

L@ top
[l I3 [}

& Sources  [52 RTL Metlist. @ Promoted Partitions

Figure 10: Promoted Partitions
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Creating Team Member Projects for usbEngine and cpuEngine
To create a consistent starting point for all team members, create multiple copies of the initial
project. For this tutorial, you will create:
e One project for the cpuEngine instance
e One project for the two usbEngine instances.
These instances are the same module and are managed by a single team member.
To create team member projects for usbEngine and cpuEngine:
1. Select File > Save Project As.
2. Enter project_TM_usbEngine as the Project Name
3. Verify Create Project Subdirectory is checked.
4

Specify the following as the Project location:
<Extract Dir>/Tutorial_ Created Data

Click OK.

b

6. Repeat the above steps with the following parameters:
e Project Name
project_TM_cpuEngine
e Project location
<Extract Dir>/Tutorial Created Data

Team Design Tutorial www.xilinx.com 20
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Step 5: Working on cpuEngine as Team Member

Acting as the team leader in the previous steps, you have:

e Set up the design.

e Created a workspace for each team member.

You will now switch roles and implement each block as a team member.

While the work of the team members is usually done in parallel, for this tutorial each team
member block is handled sequentially.

For each team member project, you will:

e Update the project sources to include the completed logic for the team member block.
e Synthesize the project.

e Implement the project.

e Promote the results.

Adding Sources to cpuEngine

Begin by adding sources to the cpuEngine project since it is already open from the last step.
Make sure that the current PlanAhead project is project_TM_cpuEngine. If it is not, open this
project now.

To add sources to cpuEngine:
1. Switch to the Project Manager view by click on Project Manager in the Flow Navigator.

2. In the Sources window, use the Hierarchy tab to expand top and select cpuEngine
(or1200 _bb.v).

This is the black box module for cpuEngine that was used for the initial project. You will now
replace this black box module with logic.

3. Right-click, and select Remove from Project.
4. Click OK.
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At the top of the Sources window, click the Add Sources icon ().

From the Add Sources wizard, select Add or Create Design Sources.

Click Next.

Click Add Directories to add the completed sources for the cpuEngine instance.

Step 5: Working on cpuEngine as Team Member

Project Manager - project_TM_cpuEngine

Sources

™ G g a_
A e =

- O

0

gt B(E

@57 Design Sources (5)
1 Werilog (2]
| Werilog Header i2)
Wi top topol (70

¥ clkgen - clock_generator (clock_generatorw)
@ rmgtEngine - mgtTop (mgtTop.w) (23]

w8 fitEngine - fitTop (ftTop.wl (1)
w8 cpuEnaine - orl 200 fop (orl 200 bbw
B & Source MNode Properties..,  <tri+E
W U8 2 Copy Text CrHC
® U3 3 open File Alt+o
== Constrai
Update File Contents. .. Ak
Replace File...
Copy File Into Project
Copy All Files Into Project A+
4 | X Remoue File from Project... Delete
Hierarchy L Enable File g Al+Equals

Figure 11: Remove or1200_bb.v Black Box Module

Browse to the following location:

./Sources/hdl/.

10. Select the or1200 directory.
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11. Click Select.

Add or Create Design Sources

Specify HDL and netlist files, or directories containing HOL and netlist files, to add to ﬁi
your project, Create a new source file on disk and add it to your project,

[ild  [Mame [Library [HDL Source for | Location
&1 orl200  work =) Synthesis & Simulation [x)

(<] [=] %]

. l =]

| Add Files... ] | Add Directories... ‘ | Create File... J

[0 Scan and Add RTL Include Files into Project
[¥| Copy Sources into Project

W] Add Sources from Subdirectories

| = Back “ Ment = || Einish ]| Cancel

Figure 12: Add Source Directory or1200

12. Verify the directory to be added.
13. Click Finish.

14. You should now see the cpuEngine module can be expanded in the Hierarchy sources view.

Synthesizing and Implementing cpuEngine

The Elaborated Design and Synthesized Design views are now out of date. To update them, you
will:

e Reload (or close and reopen) these views.

e Verify the partition settings for synthesis and implementation.

e Launch the runs.

e Promote the results.

To reload the design:

1 If the Elaborated Design view was closed, click Open Elaborated Design in the Flow
Navigator to load the latest version of the design.
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2. If the Elaborated Design view is open, the banner across the top states that the view is out of
date. Click Reload to reload the view.

Elaborated Design - xc7k70tfhg676-2 (active)

() Elsborated Design is out-of-date. Design sources were modified. more info Reload

Figure 13: Banner with Elaborated Design Status

3. Verify that cpuEngine is no longer a black box, and note that the two usbEngine instances
will remain a black box for this project.

4. Click OK.
5. In the Flow Navigator, click Specify Partitions (located under Project Manager).

In the Specify Partitions dialog box, verify the partition settings for synthesis and
implementation.

Flow Navigator «“ Elaborated Design - xc7k70tfhg676-2 (active)
o = RTL Netlist - O3 %
4 Project Manager
G2 top
#5 Project Settings Mets (9207
[C]l Specify Partitians | Primitives (12]
B clkgen (clock_generator)

# ndd Sources
= Specify Partitions

iF IP catalog Open partition settings to change options.

{d_l[{ Run Behavioral Simulation mgtEng_ine {mgtTop)
[ ushEngined (ushf top)

E ushEnginel (ushf top)

4 RTL Analysis
Y whArbEngine (wh_conmax topldw=32 aw=32 T addr=4'h]

4 Elaborated Design
@ Report DRC
% Report Noise
E| Report Utilization

i schematic
- 1 ]

4 Synthesis £ Sources [ RTL Netlist

Figure 14: Specify Partitions

7. From the Synthesis tab, verify that:
a) Top is set to Import.
b) All other partitions are set to Implement.

There is no other data to import besides the top-level synthesis results. Top is the only
partition that has been promoted.
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If Top is not set to import for synthesis, either of the following might have occurred:
e Top was not promoted correctly.

e Automatically Manage Partition Action and Import Location was not checked in the
Promote Partition dialog box.

If Top was not correctly promoted, it cannot be imported now.

o Specify whether partitions will be imported or implemented
Synthesis  Implementation

MName |Action |Impor‘t from |F'reser'-.ration |
[Cl+ top Impart |:|||anAhead Tutorial/Promote/top/synth ||I|| Routing [~
[&v cpuEngine Implement ] MA

v ushEngined Implement  [=] M

v ushEnginel Implement ] MN/&

| 0K ‘ | Cancel

Figure 15: Specify Partitions Dialog Box

8. Click the Implementation tab to verify that all partitions are set to Implement.
9. Click OK.

Optional Steps

You can skip the next two steps to save time. Instead of running synthesis and implementation,
open the completed project at:

<Extract_Dir>/Projects/project TM_cpuEngine_completed
1. In the Flow Navigator, click Run Implementation to synthesize and implement the design.
A message reports that synthesis is out-of-date.

2. Click Yes to launch synthesis prior to implementation.

Verifying and Promoting Results of cpuEngine
If you ran synthesis and implementation, the Implementation Completed dialog box displays
when implementation completes.

1. In the Implementation Completed dialog box, select Open Implemented Design.

2. Click OK.
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o Implementation successfully completed.

ext

@ 0pen Implemented Design
) Promote Partitions
() Generate Bitstream

O View Reports

[0 Don't show this dialog again

| oK |]| cancel |

Figure 16: Specify Partitions Dialog Box

If you skipped running implementation and opened the project_TM_cpuEngine_completed
design, or if the Implementation Completed dialog box did not open:

3. In the Flow Navigator, click Open Implemented Design.
e The Implemented Design view shows that:

e ThePblock for cpuEngineisrelatively full.

e The Pblocks for thetwo usbEngine instances are relatively empty.

e Because the usbEngine instances were black boxes, no logic exists for these two blocks
in the implemented design.

e The logic belonging to the Top partition is highlighted in yellow in the following figure
(Implemented Design View of the cpuEngine Project).

e Thislogic appearsin the usbEngine Pblocks because it was not restricted from being placed
inside these Pblocks.
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Metlist - O0og x L Project Summary @ Device 7 Schematic oo =
= [E] &l =
W top ]
@ [ Nets (1022) *
@ = Primitives (153)
@ clkgen iclock_generator) (13
o= @ cpuEngine (cpuEngine#orl200_td|
@ [d] fitEngine ifftTop) =
© mgtEngine (matTop) oY
L ushEnginel (LsbEngined#ushf_to|| [
[ usbEnginel (usbEnginels#usbf to|| .
@= [G] whiarbEngine (wh_conmax_top)
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@:’
o
| ] 2
& Sources [ Netlist

Figure 17: Implemented Design View of the cpuEngine Project

The Highlight Primitives tool can be used to create a highlighted view as shown in the
figure above (Implemented Design View of the cpuEngine Project).

4. To verify that timing has been met, review any of the following:
e The Timing Score in the Design Runs view
e The details of the Timing Results window
e The Timing Score in the Project Summary window

5. In the Flow Navigator, click Promote Partitions to promote the successful synthesis and
implementation results.

If the Elaborated Design view is not opened, you are prompted to open it. Click OK.
6. Select only the cpuEngine instance in both the synthesis and implementation runs.
7. Set the Promote directories.

e synth_1: <Extract_Dir>/Promote/cpuEngine/synth_1

e 1mpl_1: <Extract_Dir>/Promote/cpuEngine/impl_1

The Promote directory used in team design should be a network location or repository that
is accessible by all team members. This tutorial changes the default promote location to a
folder outside the project directory structure to emulate such a location.

8. Uncheck Automatically Manage Partition Action and Import Location.
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While disabling Automatically Manage Partition Action and Import Location is not
critical to this tutorial, Xilinx recommends removing it for team members in a team design
flow.

The cpuEngine team member might continue working on this block. Removing this option
prevents the software from automatically importing cpuEngine on the next run.

These promoted results are imported by the team leader in a later step, but are not
imported by the team member who is promoting it.

@ Please select entire runs or specific partitions to be promoted. This
copies the partitions in implemented run to the specified promote
directory. After promoting runs, you can import the partitions into
runs.

Select Partitions to promote

= B

Run | Directory | Description |
synth_1  [>romote/cpuEngine/synth 1 ||I|||cpu syrith run |
— [ top

—[ cpuEngine
— [ ushEngined
[ ushEnginel

impl.1 | ./Promote/cpuEnginesimpl 1 ||I|||cpu impl run
—[ top

— [ cpuEngine

— [ ushEngined

[ ushEnginel

Select Implementecd || Clear All |

[JlAutomatically manage Partition action and import location

|. oK ] | Cancel

Figure 18: Promote Settings for cpuEngine

9. Click OK.

Team Design Tutorial www.xilinx.com 28
UG839 (v14.1) April 24, 2012


http://www.xilinx.com/

w
i. X"-lNX Step 6: Working on usbEngine as Team Member

Step 6: Working on usbEngine as Team Member

In this Step, you will repeat the procedures of Step 5 as a team member working on usbEngine.
If multiple processors are available, you can perform this step in parallel while the cpuEngine
project is implementing.

Adding Sources to usbEngine

To add sources to usbEngine:
1. Close the current open project unless:
e You are doing this step in parallel, and
e The cpuEngine has not yet finished implementation, or has not been promoted.

2. Open the PlanAhead project:
<Extract_Dir>/Tutorial Created Data/project TM_usbEngine

3. Click the Project Manager view.

4. In the Sources window, use the Hierarchy tab to expand top and select one of the two
usbEngine instances (usbf_bb.Vv).

This black box module definition is used for the two usbEngine instances in the initial
project. It will now be replaced with logic.

5. Right-click.

6. Select Remove from Project.
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7. Click OK.
Project Manager - project TM_usbEngine
Sources - 0O o =
A= 2B
@ Design Sources (5]
| Werilog (2]
| Werilog Header (2)
wEgy top (topw) (7]
wi clkgen - clock_generator (clock_generatorw)
@ mgtEngine - mgtTop (matTop.w) (23]
w fitEngine - fftTop ifftTop.w) (1)
¥ cpuEngine - orl200_top (orl200 bb.w)
w8 whirbEngine - wh_conmax top (wh conmax top.v) (25)
we ushEngined - ushf top (ushf bba
@ usbEnging  [3 Source Mode Properties... <trHe
@ Constraints (1) I Copy Text CtrHC
* Open File Alt+o
Update File Contents... A+l
Replace File...
Copy File Into Project
Copy All Files Into Project Al
# Rermove File from FProject... Delete
Hierarchy Libraries Enahkle File Ak+Equals
o = Dizable File AlHMinUs
83 Sﬂurces : T BAmim b Cieealmdimes Cm e -
Figure 19: Remove Black Box Module usbf_bb.v
. . . =h
8. At the top of the Sources window, click the Add Sources icon (7).
9. From the Add Sources wizard, select Add or Create Design Sources.
10. Select Next.
11. Click Add Directories.
12. Browse to:
/Sources/hd1/
13. Select the usbT directory to add the completed sources for the usbEngine instance.
14. Click Select.
15. Click Add Files
16. Select the file:
/Sources/hdl/rtlRam.v
17. Verify the file and directory to be added.
18. Click Finish.
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Synthesizing and Implementing usbEngine

To synthesize and implement usbEngine:
1. In the Flow Navigator, click Open Elaborated Design to open the Elaborated Design view.
2. Verify that the two usbEngine instances are no longer black boxes.
3. In the Flow Navigator, click Specify Partitions (located under Project Manager).
5. From the Synthesis tab, verify that:
e Top is set to Import.
e All other partitions are set to Implement.

There is no other data to import besides the top-level synthesis results. Top is the only
partition that has been promoted.

If Top is not set to import for synthesis, either of the following might have occurred:
e Top was not promoted correctly.

e Automatically Manage Partition Action and Import Location was not checked in the
Promote Partition dialog box.

If Top was not correctly promoted, it cannot be imported now.
6. Click the Implementation tab to verify that all partitions are set to Implement.

7. Click OK to exit the Specify Partitions dialog box.

Optional Steps

You can skip the next two steps to save time. Instead of running synthesis and implementation,
open the completed project at:

<Extract_Dir>/Projects/project_TM_usbEngine_completed
1. In the Flow Navigator, click Run Implementation to synthesize and implement the design.
A message reports that synthesis is out-of-date.

2. Click Yes to launch synthesis prior to implementation.

Verifying and Promoting Results of usbEngine

To verify and promote results of usbEngine:
1. Open the Implemented Design view.

If you ran synthesis and implementation, the Implementation Completed dialog box displays
when implementation completes.

2. In the Implementation Completed dialog box, select Open Implemented Design.
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3. Click OK.

If you skipped running implementation and opened the project_TM_usbEngine_completed
design, or if the Implementation Completed dialog box did not open, click Open
Implemented Design from the Flow Navigator.

4. The Implemented Design view shows that:
e The Pblocks for usbEngine0 and usbEnginel are relatively full.
e The Pblock for the cpuEngine instance is relatively empty.

Because the cpuEngine instance was a black box, it is expected to be empty. However, some
logic can be seen in this region. The logic from the top level partition was not restricted from
being placed inside the cpuEngine Pblock.

You can use the Highlight Primitives tool to create a highlighted view.

Metlist - O o ® E Project Summary % Device 7 Schematic Og *

= H[E] 3

s top

©= = Nets (1022) *

@ = Primitives (153]

o clkgen (clock_generator) Qr
[ cpuEngine (cpuEngine#orl200_tq|

@~ [@] fitEngine (fftTop) L\

a,]

[

© mgtEngine (rmgtTop)

o ushEngined (ushEngined#ushf ol
@ usbEnginel (usbEnginel#usbf_tol
@ wharbEngine (wh_conmas_top)

4 ]

& Sources [ Netlist

Figure 20: Implemented Design View of the usbEngine Project

5. To verify that timing has been met, review any of the following:
e The Timing Score in the Design Runs view
e The details of the Timing Results window

e The Timing Score in the Project Summary window
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6. In the Flow Navigator, click Promote Partitions to promote the successful synthesis and
implementation results.

7. If the Elaborated Design view is not opened, you are prompted to open it. Click OK.

8. Select only the usbEngine0 and usbEnginel instances in both the synthesis and
implementation runs.

9. Set the Promote directories.
e synth_1: <Extract_Dir>/Promote/usbEngine/synth_1
e impl_1: <Extract Dir>/Promote/usbEngine/Zimpl_1

10. Uncheck Automatically Manage Partition Action and Import Location.

@ Please select entire runs or specific partitions to be promoted. This
copies the partitions in implermented run to the specified promote
directory. After promoting runs, you can import the partitions into
Funs.

Select Partitions to promote

=

Run |Direct0ry | Description
synth_1 ||jromotefustnqinefsvnth 1 ||I||usb synth run
— [ top
— [ cpuEngine

— [ LusbEngined
vl ushEnginel

impl_1  [/PromotesusbEnginesimpl 1 || - |lusk impl run
— [ top
— [ cpuEngine

— [ LusbEngined
— [ usbEnginel

Select Implemented || Clear All |

[Jautomatically manage Partition action and import location

|| 0K |l | Cancel

Figure 21: Promote Settings for usbEngine0 and usbEnginel

11. Click OK to promote the usbEngine0 and usbEnginel partitions.
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Step 7: Running the Assembly as Team Leader

In the previous steps, each team member synthesized, implemented, and promoted a version of
their block. The team leader can now assemble the design. The team leader:

e Reopens the team leader project.

e Sets up the partitions for import.

Setting Up the Team Leader Project To Do an Assembly Run

To set up the team leader project to do an assembly run:

1. Reopen the following project:
<Extract_Dir>/Projects/project TL

This is the original project. It already contains:
e The defined team member partitions

e The successful synthesis results of Top

e The Pblocks for the team member blocks

2. Update the project to define the team member blocks as logic instead of black boxes. To do
this, add the successful synthesis results (NGC) from each team member’s promoted
synthesis run.

From the Project Manager, click Add Sources.
Select Add or Create Design Sources.

Click Next.

Select Add Files.

N o oA~ W

Add the following files:

e <Extract Dir>/Promote/usbEngine/synth_1/usbEngineO#usbf_top.ngc
e <Extract _Dir>/Promote/usbEngine/synth_1/usbEnginel#usbf_top.ngc
e <Extract _Dir>/Promote/cpuEngine/synth_1/cpuEngine#or1200_top.ngc
8. Click Finish.
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Add or Create Design Sources
Specify HOL and netlist files, or directories containing HOL and netlist files, to add to yvour féﬂ
project, Create a new source file on disk and add it to vour project.
I [name [Library  [HDL Source for [ Location
i® 1 usbEngined#usbf top.nge Mis iR [= -
2 ushEnginel#usbf top.nge ik MR (] [ |
3 cpuUENgine#orl 200_top.ngec MR MAA (= |:|
b2
€]
|| Add Files... |‘ | Add Directories... ‘ | Create File...
[ Sean and Add RTL Include Files into Project
[¥] Copy Sources into Project
7] Add Sources from Subdirectories
| = Back J| et = || Finish ‘ | Cancel

Figure 22: Add Post Synthesis Results for Team Member Partitions

In the Flow Navigator, click Open Synthesized Design

to open the Synthesized Design view.

All partitions are now defined for this project. It is not necessary to rerun synthesis. The
latest synthesis results of all team members (including the team leader) are used for this

assembly run.

Synthesized Design - xc7k70tfhg876-2 (active)
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sl top

| Mets (1022)

| Primitives (153)
clkgen fclock_generator)
cpuEngine {cpuEngine#orl 200 top)
[G] fitEngine (ftTop)
mgtEngine (rmatTop!
ushEngined (ushEngine0#ushf top)
[@ ushEnginel (usbEnginel#ushf top)
[T wharbEngine (wh_conmax_top)
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Figure 23: Synthesized Design With All Partitions Defined, and No Black Boxes
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Updating Partition Settings and Running the Assembly

To update partition settings and run the assembly:

1.

In the Flow Navigator, click Specify Partitions and access the Implementation Partition
settings. The Synthesis tab can be left as is since synthesis is not being ran.

Leave the Top partition action as Implement.

Change the following remaining partition actions to Import:
e CpuEngine

e usbEngine0

e usbEnginel

Change the Import from field to the location to which the team members promoted the
implementation results.

e cCpuEngine: <Extract_Dir>/Promote/cpuEngine/Zimpl_1
e usbEngine0: <Extract_Dir>/Promote/usbEngine/impl_1
e usbEnginel: <Extract_Dir>/Promote/usbEngine/Zimpl_1

Because both usbEngine instances were implemented together and promoted together, the
Import From location is also the same.

o Specify whether partitions will be imported or implemented
Synthesis Implementation

MName |Action |Import from |Preser‘-.ration |
O top Implement [ MR

&+ ushEngine Import [~|['Fromote/usbEnainesimpl 1 || - | Routing [+
@+ ushEnginel Import [~|['Promote/usbEnaine/impl 1 || - | Routing B
&+ cpuEngine Import [~|[Fromote/cpuEnainesimpl 1 || - | Routing [+

|| oK " | cancel

Figure 24: Partition Settings for Assembly Run

Click OK.
Click OK on the Reset out-of-date run dialog to reset impl_1.

You do not need to run the next step in which you run implementation. To save time, open
the completed project at:

<Extract_Dir>/Projects/project_TL assembled

Team Design Tutorial www.xilinx.com 36
UG839 (v14.1) April 24, 2012


http://www.xilinx.com/

i: X"—l NX Step 7: Running the Assembly as Team Leader

7. Optional. Click Run Implementation in the Flow Navigator to launch implementation and
assemble the full design.

Verifying and Promoting Assembly Results

In this design:

e Each team member block is logically isolated from other team member blocks.
e All the boundaries are registered.

e The placement of each team member block was sufficient the first time through.

For more complex designs, this assembly run may be the first of many. The process described in
this tutorial may be repeated as necessary.

Each team member project can now start to import other team member blocks from this
promoted assembly run. This helps interface timing to converge early in the design cycle,
instead of leaving other team member blocks as black boxes and discovering interface timing
issues at the end of the design.

To verify and promote the assembly results:

1. Open the Implemented Design view.

2. In the Implementation Completed dialog box, select Open Implemented Design.
3. Click OK.

If you skipped running implementation and opened project_TL_assembled, or if the
Implementation Completed dialog box did not open, click Open Implemented Design from the
Flow Navigator.

When the Implemented Design view opens, you can see the entire design. The figure below
(Implemented Design View of the Assembled Design) shows an example of this placement. The
figure uses the highlight colors shown in the following table.

Item Highlight Colors
usbEngine0 red

usbEnginel blue

logic belonging to the Top partition yellow
cpuEngine green

You can use the Highlight Primitives tool to create this highlighted view.
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Figure 25: Implemented Design View of the Assembled Design

Verifying That Timing Has Been Met

To verify that timing has been met, review any of the following:
e The Timing Score in the Design Runs view
e The details of the Timing Results window

e The Timing Score in the Project Summary window
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Verifying That All Team Member Partitions Were Imported

To verify that all team member partitions were imported, review the Implemented Partition
section of the Project Summary view.

[C] implemented Partitions

*»

top cpuEngine
Type: Mormal Type: Marmal
State: Implernent State: Import
PAR. Preservation Level: Routing Import Location: otefcpuEngine/impl
Boundary Optimization:  MNone PAR Preservation Level:  Placement

Modified Impart Logic: Routing
Boundary Optimization:  Mone

usbEngine0 usbEnginel
Type: Mormal Type: Marmal
State: Import State: Import
Import Location: otefushEnginesimpl Import Location: otefusbEngine/impl
FPAR Preservation Level:  Flacement FAR Preservation Level:  Flacement
Modified Import Logic: Routing Modified Impaort Logic: Routing
Boundary Optimization:  Mone Boundary COptimization:  Mone

Go To: Specify Partitions

Figure 26: Partition Summary Section of Project Summary

Promoting Successful Synthesis and Implementation Results

Modifications to the design may require some or all of this flow to be repeated. Using these
successful assembly results in future iterations may be beneficial. To promote the successful
synthesis and implementation results:

1. In the Flow Navigator, click Promote Partitions.
2. If the Elaborated Design view is not opened, you are prompted to open it. Click OK.
3. Select all partitions in both the synthesis and implementation to be promoted.

Because the placement of the Top partition meets all interface timing, each team member
can now begin to import Top, as well as other team member partitions to maintain this
interface timing in all future iterations.

4. Set the Promote directories:
e synth_1: <Extract_Dir>/Promote/top/synth_1
e impl_1: <Extract Dir>/Promote/top/impl_1

For this tutorial, the synthesis results for the team leader have not changed from the last
time they were promoted. However, the team leader might develop additional logic in the
top level design in parallel with the other team members. In this case, promoting synthesis
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and implementation results at this stage ensures that all team members are working on the
latest code.

5. Uncheck Automatically Manage Partition Action and Import Location.

Disabling Automatically Manage Partition Action and Import Location prevents the
software from automatically changing the import locations of the team member partitions to
the location to which they were just promoted (Promote/top).

Instead, the software maintains the locations defined in the previous steps. This simplifies
running the assembly step in future iterations.

o Please select entire runs or specific partitions to be
promoted. This copies the partitions in implemented run to
the specified promote directory. After promoting runs, you can
impart the partitions into runs,

Select Partitions to promote

= =

RUM | Directory | Description
gynth_1 ||3rom0teft0pfs~,fnth 1 ||Z|||TL synth run
— [ top

— M cpuEngine

— b ushEngined

[ ushEnginel

impl_1 [ _/Promotestopsimpl 1 ||:||TL irnpl run
— [ top

— ¥l cpuEngine

— [ usbEngined

= vl ushEnginel

| Select Implemented || Clear All |

[Jlautomatically manage Partition action and import location

| oK ] | Cancel

Figure 27: Promote Settings for Assembled Design

6. Click OK.
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Conclusion

In this tutorial, you did the following:

e Used partitions and the Team Design methodology to synthesize and implement a design in

multiple parts.
e Assembled the full design.
e Synthesized and implemented blocks as black boxes.
e Promoted successfully synthesized and implemented partitions to a central repository.

e Created PlanAhead projects for each team member.
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